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 VCS Modes and Optional Add-Ons  
VCS can capture data in one of two hardware modes: 
asynchronous serial, Ethernet. Version 3.3 comes with one 
executable installer that is configured to be a particular VCS 
model by means of the serial number. You need one installation 
for each mode   
  
Instructions Contained In the Quick Start Guide  
This Quick Start Guide contains hardware setup information for 
the serial and Ethernet modes.  Just go to the section for the 
hardware mode you want to use.  Each section will contain 
instructions for setting up the hardware and how to set the I/O 
settings.    
  
The software for all modes is identical in many respects so there is 
just one set of instructions on how to use the software.  
  
The license for VCS allows you to run in either asynchronous serial 
or Ethernet mode on one machine only.  If you need to run in two 
or more different modes concurrently on the same PC or on two 
different PCs, please contact Frontline Test Equipment, Inc. to 
purchase an additional license.  
 

Minimum System Requirements  
  
• PC with Windows 95 OSR2 (version 950b), Win 98, Win Me, Win 

NT, Win 2000, Windows XP, or Server 2003 and a Pentium 
processor or higher. (Note: When installing on Server 2003 you 
will get a notice “… OS Not Supported …” which is a leftover 
from days before the testing on this OS—ignore it. 

• RAM Requirements: 64M for 95/98/Me/NT, 128M for 2000/XP  

• 50 MB free Hard Disk Space (capture file size is limited by disk 
size)  

• Minimum of one COM port, two required for bi-directional 
monitoring (required when using cable set)  

• VCS supports COM1 through COM64  

• Ethernet NIC (required when capturing Ethernet data)  



• Maximum data rate supported is dependent on PC processor 
speed. Models of asynchronous VCS are available for either 
115.2 Kbps or (HS or High Speed) models at up to 921.6 Kbps. 

Desirable System Configuration 

• PC or laptop with Pentium 4 or better processor 

• Windows 2000, XP, or Server 2003 

• 512 Mb or greater RAM 

• Two COM ports—on approved Quatech hardware (for VCS 
Async models only). 115.2 Kbps for normal models, 921.6 Kbps 
for HS models. 

• One 10/100 Ethernet NIC (for VCS Ethernet only) 

Technical Support  
  
Technical support is available in several ways.  The answers to 
many questions can be found in the online documentation, the 
VCS System brochure, online FAQ, TechNotes and other 
documentation on  sysFire’s web site {HYPERLINK 
"http://www.greenleafsoft.com/"} has documentation on 
common problems, as well as software upgrades and utilities to 
use with our products.  
  
Web: {HYPERLINK "http://www.greenleafsoft.com"} – click on 
Support | Tech Support and fill out the form for your type issue. 
Email: {HYPERLINK "mailto:Support@GreenleafSoft.com"}
 
If you need to talk to a technical support representative, support is 
available between 9am and 5pm, Central time (GMT-600), Monday 
through Friday.  Technical support is not available on U.S. national 
holidays.  
 
Please submit a Technical Support Request via the website or by 
email to {HYPERLINK 
"http://www.greenleafsoft.com/VCSBroch/VCS-Cable-Guide.pdf"}.  
If you need to talk with us by phone, please indicate phone 
number and best time of day to reach you. 
  
Fax: +1 (972) 980-6425 or +1 (214) 349-3650 

http://www.greenleafsoft.com/
http://www.greenleafsoft.com/
http://www.greenleafsoft.com/
mailto:Support@GreenleafSoft.com
http://www.greenleafsoft.com/VCSBroch/VCS-Cable-Guide.pdf
http://www.greenleafsoft.com/VCSBroch/VCS-Cable-Guide.pdf


  

Welcome to VCS! 
The VCS family of products is designed to let you conduct data 
analysis of protocols using your personal computer.  The VCS 
interface is easy to use without training, but you will want to read 
the online Help to learn how to take maximum advantage of all 
the features.  
  
We have tried to make the online Help complete and easy to use.  
You can reach the online Help by choosing Help Topics from the 
Help menu, or by pressing the F1 key on any window.  
  

1 Installing the Software  

• Insert the media into the drive.  After a brief pause, the 
installation should automatically start.  

• If installation does not automatically start, run SETUP.EXE.  You 
can do this from the command line, Windows Explorer, or the 
Add/Remove Programs icon in the Control Panel.  

• Select your product from the list and click "Go".   

• Enter your product serial number when prompted.  

• Some VCS products will allow you to purchase decoder add-
ons.  If you have one of these products and you have 
purchased decoder add-ons (i.e. Modbus, Allen-Bradley, etc.), 
enter the authorization code for the first decoder add-on at the 
Install Add-On(s) prompt and click the "Install" button.  If you 
have purchased more than one decoder add-on, repeat the 
process with each authorization code.  When finished, click the 
"Done" button.  If you have not purchased any decoder sets, 
click the "None" button.  

• Continue with installation, following the instructions on your 
screen.  

• Register online at { HYPERLINK 
"http://www.GreenleafSoft.com/Register.asp" } 

http://www.greenleafsoft.com/Register.asp
http://www.greenleafsoft.com/Register.asp


2 Installing Decoder File Sets  
If you purchase a ProtocolPack  or develop a new custom decode 
some time after purchasing VCS, you may follow these steps to 
install the decoder file set. 
    
• Go to the Start button and choose VCS -> Optional 

Components -> Install Product Add-on.  

• Enter the authorization code for the decoder file set and click 
the "Install" button.  If you have purchased more than one 
decoder set, repeat the process for each decoder set.  

• Click "Done" when finished.  

• The authorization code is based on the serial number of your 
VCS software, which means that if your company has 
purchased multiple copies, you will need to keep the software 
serial numbers with their corresponding decoder authorization 
codes.  

 

3 Starting VCS  
When your product is installed, an icon or a folder will be created 
on the desktop.  Double-click the product icon.    
  
The first time you run the program, the Hardware Settings 
window will appear.  Below are instructions for the different types 
of Hardware Settings windows: Ethernet, asynchronous serial, 
synchronous serial and  Greenleaf ViewComm.  
  
You can always change any setting by choosing Options | 
Hardware Settings from the VCS Control window.   
  

Ethernet Hardware Setup  
VCS will work with any Ethernet card with an NDIS driver.  Some 
wireless cards do not pass all frames through the card and so the 
amount of data captured may not represent all the data on the 
Ethernet segment.  
  
Please refer to the card documentation for instructions on 
installing your Ethernet card.  



application you selected.  If your protocol stack is not selected or 
you want to change the protocol stack selected, click the Custom 
Protocol Stack button to select a protocol stack.  Select the correct 
stack (stacks are usually named by their base layer) and click 
Finish.  To set up a stack not listed, select the "Build Your Own" 
option from the top of the list and click Next.  Click the Close 
button.  
  
Some protocols have additional setup requirements.  Please read 
the online Help for information or refer to the supplementary 
document that came with your decoder set for these protocols.  
  
You are now ready to begin capturing data.  Skip to the section on 
"Using VCS - The Tour".  

"Source DTE, No Cables" Mode  
Source DTE, No Cables allows you to transmit data as a DTE device 
and monitor the DCE response without the use of cables.  You can 
transmit data to an external device through a serial port or to an 
internal device, such as an internal modem.  

Tell VCS Which Port to Use  
1. Open the Hardware Settings window.  This window will come 

up automatically the first time VCS is run, or you can choose 
Hardware Settings from the Options menu on the Control 
window to access it at any time.  

2. At the top of the window are radio buttons for choosing which 
mode to use.  Click the radio button for "Source DTE, No 
Cables".  

3. Select the COM port to use in the top box in the middle of the 
window.  

4. Click OK.   
5. Connect your DCE device to the same COM port.  
  
If you need to change the COM port at any time in the future, start 
VCS and choose Hardware Settings from the Options menu on the 
Control window.  

Set the I/O Configuration  



Before you can begin capturing data, you need to tell VCS what 
data rate to transmit at.   You give VCS this information in the Set 
I/O Configuration window.    
  

1. Click on the Set I/O Configuration icon   on the Control 
window toolbar, or choose Set I/O Configuration from the 
Window menu.   

2. The operating mode is automatically set to Source DTE.  
3. Set the baud, parity, word length and stop bits to the correct 

settings for both sides of the circuit.   
4. Click the Close button.  
  
You are now ready to begin transmitting data.  Skip to the section 
on "Using VCS - The Tour" to learn about the Transmit window 
and how to monitor the response from the DCE.  
  
 

How To Capture Data  
VCS can capture data to a memory buffer or to a file on disk.  Data 
capture can be initiated from the Control window, the Event 
Display, the Frame Display or the Protocol Navigator, though you 
do not need any window other than the Control window open to 
capture data.  For ease in reading, the word "buffer" below will 
refer to either data in memory or in a capture file.  
  

To capture to the buffer, click the Start Capture to Buffer icon  .  
  

To capture to a file, click the Start Capture to Disk icon   and 
type a filename when prompted.  
  

To stop capture and reset the buffer, click the Clear icon  .  
Clearing the buffer throws away the data in memory.  If you want 
to save the data in the buffer, pause capture (see below) and save 
the buffer before clearing it.  
  

To stop capture to disk and close the file, click the Close icon  .  



  

To pause capture, click the Pause/Resume icon  .  Click the 
Pause/Resume icon again to resume capture.  Pausing capture 
means that no data will be added to the capture buffer or file until 
capture is resumed.  
  
If the buffer becomes full, data capture will begin to wrap, which 
means the oldest data will be overwritten by new data. You can 
tell how full the buffer is by checking the bar graphic next to 
Capture Status on the status bar of the Control window.  If you do 
not want the buffer to wrap, choose System Settings from the 
Options menu on the Control window and uncheck the "Wrap 
Buffer" box.    
  

Looking At Data Bytes  

Event Display  

Click the Event Display icon   on the Control window toolbar 
to open the Event Display.  The Event Display window is the main 
view of byte-level data.  

How Data Is Displayed  
Data is displayed in hex on the left and ASCII on the right.  You can 
restrict the display to only show Hex or ASCII using the buttons at 
the top of the window.  The Event Display can also display data in 
decimal, binary, EBCDIC, and other character and number formats.  
Choose the format you would like from the Data menu, or right-
click on the Hex/ASCII labels in the headers and select a different 
format.  
  
Click on a byte in the display.  The three status lines at the bottom 
of the window will update to show a variety of information about 
the byte, including its value in different radixes and any errors 
associated with the byte.  Use the mouse to select several bytes.  
The status lines change to show the data rate over the range of 
the selection, the delta time between the first and the last bytes in 
the selection, and the CRC.  To change the algorithm used to 



calculate the CRC, click the CRC icon  .  
  
Bytes with errors are shown in red.  Click on the byte to see what 
the error is.  
  
VCS displays data other than bytes in the Event Display.  Control 
signal changes are indicated with an up-and-down arrow.  Flags 
are used as start-of-frame and end-of-frame markers.  These 
special symbols in conjunction with the data bytes are called 
events.  

Scrolling versus Static View  
By default, the Event Display scrolls as data is captured so that it 
always shows the latest data.  To prevent the Event Display from 

scrolling, click the Toggle Display Freeze icon  .  Click the 
Freeze icon again to resume scrolling.  
  

Looking At Frames  

Frame Display  

Click the Frame Display icon   on the Control window toolbar 
to open the Frame Display.  This display allows you to have bit 
level visibility on your protocol.  

Panes  
The Frame Display is divided into panes, where each pane shows a 
different view of the data.  The Summary pane stretches across the 
top of the display.  Each line in the Summary Pane represents one 
frame/message.  The Decode pane contains a detailed decode of 
the frame selected in the Summary pane, and is located on the left 
side of the Frame Display window.  The three smaller panes on the 
bottom right of the Frame Display show the logical data in hex, 
binary and ASCII.  Select any field in the Decode pane and the 
corresponding bit(s) or byte(s) will be selected in the logical data 
panes.  



Frame Errors  
A frame number in red indicates an error in the frame.  Select the 
frame, and look at the top of the Decode pane to determine the 
type of error.  

Scrolling versus Static View  

Click the Freeze/Resume icon   to have the Summary pane 
scroll to always show the latest frames captured.  Click the 
Freeze/Resume icon again to stop the Summary pane from 
scrolling.  

Protocol Tabs  
The frame display has a series of Protocol Tabs that allow you to 
filter on a specific protocol quickly and easily.  For more advanced 
filtering option please consult the online Help.  

Protocol Navigator  

Click the Protocol Navigator icon   on the Control window 
toolbar to open the Protocol Navigator. The Protocol Navigator 
window presents decodes of multiple protocol layers within 
multiple data frames/messages. It simplifies the process of 
understanding the complex relationships between multiple data 
frames/messages and the protocol layers that comprise the 
frames. The three window panes on the left of the Protocol 
Navigator enable you to select or suppress protocols of interest.  

Hiding and Revealing Protocols  
Hiding means that the selected protocol is not displayed in the 
main window pane, even though it may be present in a frame.  
This allows you to zoom in on protocols of interest by hiding all of 
the ones that aren’t of interest.  
There are two ways to hide a protocol in the Protocol Navigator 
window.  
  
1. Right-click on the protocol in the main window pane and 

choose Hide [Protocol Layer Name].  
2. On the middle window pane, the Hidden From View pane, 

check the boxes next to the protocols you want to hide.  



  
To reveal a hidden protocol, right-click anywhere in the main 
window pane and select the protocol you want to show from the 
right-click menu, or uncheck the box next to the protocol name in 
the Hidden From View pane.  

Filtering on a Protocol Layer  
You can filter on one or more protocol layers by using the top 
window pane, the Filtered In pane. Check the boxes next to the 
names of the protocols you want to filter in. The filter is inclusive, 
which means that filtering on a protocol displays only frames that 
contain that protocol.  Frames that do not contain the protocol 
will not appear.  You can filter on one or more protocols.  

Using Named Filters  
VCS comes with predefined Named Filters.  You can apply one or 
more of these filters by checking the boxes next to the names of 
the filters you want to use.  You can create your own named filters.  
Please consult the online Help under Filtering for instructions.  
  

Common Features  

Display Synchronization  
The Frame Display is synchronized with the Event Display and 
Protocol Navigator.  Select a frame in the Frame Display and the 
other windows will automatically update to highlight the bytes in 
the frame.  Select a byte in the Event Display or Protocol 
Navigator, and the Frame Display will update to show the frame 
containing the byte.   

Duplicate Displays  

The Duplicate icon   creates a second window of the same 
type, identical to the first.  The advantage of additional Displays is 
that you can look at two different groups of data at the same time.  
For example, you can look at the start of an interaction in one 
Frame Display and the end of that same interaction in the other 
and compare the two.  



Bookmarks  
Bookmarks let you mark frames of interest so they can be easily 
found later.  Bookmarked frames appear with a magenta triangle 
icon next to them except in the Event Display where they appear 
as a dashed line around the start of frame marker.  You can 
navigate between bookmarks using the Find feature or by 
pressing F2 to go to the next bookmark.  To make a new 
bookmark, right-click on the frame and choose Add Bookmark 
from the menu.  

Searching  
You can search for strings or patterns in your data or in the frame 
decode, for errors, control signal changes, bookmarks, special 

events, and time.  Click the Find   icon to open the Find 
window. Click the Help button for more information on the 
different types of searches.   
  

Statistics  

Click the Statistics icon   on the Control window toolbar to 
open the Statistics window.  
  
The Statistics window provides a statistical overview of all the data 
on the circuit.  VCS is always monitoring the circuit and gathering 
statistics, even when not capturing the data.  
  
There are three tabs on the Statistics window: Session, Reset able 
and Buffer.  The Session tab shows statistics from the time VCS 
was started.  The Reset able tab can be reset to show statistics 
from the time the Reset icon was last pressed.  The Buffer tab 
shows statistics on the data in the capture buffer.  If data capture 
has not been started or if the buffer has wrapped, most of the 
statistics on the Buffer tab will be n/a.  
  
Some tables on the Statistics window can display data in graphic 

form.  Click the Graph icon   on any header that has one for a 
chart of that table.  
  



Monitoring Control Signals  
(Serial Analysis Only)  
  
The Breakout Box monitors control signals in real-time.  The Signal 
Display is an overview of all signal changes in the capture buffer. 
  

Breakout Box  

Click the Breakout Box icon   on the Control window toolbar 
to open the Breakout Box window.  
  
The Breakout Box monitors the six main control signals on an RS-
232 circuit.  It displays a count of how many times each signal has 
changed since the Breakout Box was opened, and shows the state 
of the signal using green and red symbols and line charts.  

Signal Display  

Click the Signal Display icon   on the Control window toolbar 
to open the Signal Display.  
  
The Signal Display shows the state of the control signals in the 

capture buffer over time.  With the Snap To   feature on, click 
on any control signal line and VCS will jump to the nearest signal 
change.  The Signal Display is synchronized with the Event 
Display.  Click on any signal change in the Signal Display and the 
corresponding event will be automatically selected in the Event 
Display.  
  

Click the Find icon   to search for signal changes.  If you are 
capturing data, you can update the Signal Display by clicking the 

New Snapshot icon  .  

5 Exiting VCS  
To exit VCS, go to the File menu on the Control window, and 
choose Exit VCS, or close the Control window using the X icon in 
the top right corner of the title bar.  



  
Copyright © 2002-2005 sysFire LLC. 
Copyright © 2002-2004 Frontline Test Equipment, Inc.  All rights 
reserved.  You may not reproduce, transmit, or store on magnetic 
media any part of this publication in any way without prior written 
authorization of Frontline Test Equipment, Inc.  
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